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Micro Focus COBOL Server 5.0 Release
Notes

These release notes contain information that might not appear in the Help. Read them in their entirety
before you install the product.

Note:

• This document contains a number of links to external Web sites. Micro Focus cannot be
responsible for the contents of the Web site or for the contents of any site to which it might link.
Web sites by their nature can change very rapidly and although we try to keep our links up-to-date,
we cannot guarantee that they will always work as expected.

• Check the Product Documentation section of the Micro Focus SupportLine Web site for any
updates to the documentation which might have been uploaded.

COBOL Server provides the execution environment for applications created with any IDE variant of Visual
COBOL.

Updating from earlier versions of COBOL Server

Note: This applies to Windows platforms only.

As a result of an internal change of your product, you must at least relink any executable programs
compiled with a product version earlier than 4.0, to make them compatible with the latest run-time system.
However, a full recompilation of your source code is the recommended action, to allow your executables to
benefit from the product's latest programming and performance enhancements.

Relinking an executable without recompiling means using the original object code with the cbllink utility,
using the current version of Visual COBOL. Original object code is typically the binary file output (usually
containing the .obj extension) produced during the original compilation process. An application can
contain one or more binary files.
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What's New
This release provides enhancements in the following areas:

• Enterprise Server Common Web Administration
• Consolidated Trace Facility
• Data File Tools
• Database Access
• Enterprise Server Security
• Platform Support

Enterprise Server Common Web Administration
Back to Top

Note: This feature is in Early Adopter Product (EAP) release status.

Visual COBOL now includes a new Enterprise Server Common Web Administration interface (ESCWA).
ESCWA is a web user interface and server for modern administration, monitoring and control of Enterprise
Server. It offers improved usability that consolidates the different Enterprise Server user interfaces so that
native and managed regions, and security stores can be managed in one place. Features include:

• Administering directory servers across multiple hosts.
• Monitoring and control of Enterprise Server instances.
• Configuring and administering a security store, defined in an LDAP-compatible security manager such

as Microsoft Active Directory or OpenLDAP.
• Administering the Scale-Out features - enable you to specify logical groups of Enterprise Server

instances, and configure and run Performance Availability Clusters (PACs) and their related Scale-Out
Repositories (SORs).

• Administering, monitoring and control of Enterprise Server for .NET regions and listeners.
• The use of current web frameworks that have a greater focus on security.
• (Included with 5.0 Patch Update 2 ) - support for Enterprise Server XA, MQ and PL/I configuration and

monitoring. This includes support for XA resources, configuring MQ, Listeners and Writers, PL/I, MFCS
console, Region Trace options, displaying the current ESMs on logon page and Local/loopback
connections warning changes.

Consolidated Trace Facility (CTF)
Back to Top

This release provides the following enhancements:

• Dynamic CTF - it is now possible to configure the CTF dynamically from outside the process being
traced.

Using a new command line utility - cblctd - you can alter the tracing events of running applications
that already have CTF tracing enabled. You can alter trace levels, add or remove components to or from
the trace, and also configure the emitters in effect.

Additionally, there is also a new component that you can trace - mf.mfdbfh enables you to trace activity
of the Micro Focus Native Database File Handler.
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Data File Tools
Back to Top

This release provides the following enhancements:

• The Data File Editor now includes a Compare Files tool that enables you to compare the contents of
two data files side-by-side.

• Structure files, and the layouts within them, can now be created within the Data File Editor; you no
longer need to use the Classic Data File Tools utility to manage your layouts.

• When connecting to a VSAM dataset stored in an enterprise server region, you can store any
passwords required for access, for the duration of your current session.

• You can view archived JES spool jobs that have been merged into one spool file using the merging
archived spool files process.

• You can now quickly duplicate records in non-indexed files, using the Duplicate Record option.

Database Access
Back to Top

Enhancements are available in the following areas:

OpenESQL ADO.NET Connection Editor Toolbar

• A new "i" (information) button is available that provides all the details of any installed .NET provider.
Provides additional information mitigating resource definition and use within the ADO.NET Connection
editor

• Static XA switch modules "Reconnect" - At the beginning of a global transaction, the XA switch will
attempt to reconnect temporarily broken connections to the database. If there is a temporary disconnect
to the database, there is no need to manually re-enable the XA switch to run transactions.

Enterprise Server Security
Back to Top

This release includes the following enhancements:

• Security - security features can now be employed when developers and administrators install new
COBOL services (web services and EJBs) into an enterprise server instance over the network. There
are a number of authentication and authorization options that can be enabled. See Deployment
Listeners and The .mfdeploy File in your product Help.

• Vault Facility - a new security feature has been added that enables some Enterprise Server components
to keep certain sensitive information in a form of storage defined as a vault, accessible via a
configurable vault provider. The default vault provider stores data in encrypted format on disk.

• OpenSSL 1.1.1 - the OpenSSL security provider has been updated to OpenSSL version 1.1.1.

This is the stable Long Term Support version of OpenSSL.

• Added support for the ratified TLS protocol version 1.3. TLS 1.3 benefits include:

• Much shorter initial connection negotiation sequence. This reduces the time taken to establish a
link before starting to transmit data.

• Using only the most secure ciphers and hash methods.
• TLS 1.3 will be negotiated in preference to the older TLS protocols.
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• Added support for new Ciphers and Key Exchange groups in line with TLS 1.3 requirements.
• The default security level for previously configured endpoints has been moved from Security Level 0

to Security Level 1. This removes the ability to accidentally make use of known-weak elements such
as SSL3 and MD5. Similar changes to the default Security Level have recently happened to Java,
Chrome, Firefox, and other systems providing secure connections.

• Fileshare Security - the Fileshare Secure TCP/IP transport provider now supports the trusted use of
X509 certificates bearing the name of the Fileshare service as the Common Name element of the
certificate.

In previous releases, a secure connection to a Fileshare server was made using a certificate that
represented the network location upon which the Fileshare service was located. This method is still
supported, but does not distinguish between the exact Fileshare server that is being connected to when
more than one service can exist on a single host system. With this change, individual Fileshare services
can identify themselves by using a unique certificate. While running on the same host and registered
with the same network endpoint.

• Support for Active Directory user groups and group name mapping - the Enterprise Server External
Security Facility's MLDAP ESM Module can now use Active Directory user group objects for Enterprise
Server user groups. Also, the module can now map long group names to the 8-character-maximum
names required for mainframe emulation.

• Selective auditing - administrators can audit only security activity of particular interest, reducing audit
overhead and the volume of events. The Enterprise Server External Security Facility's MLDAP ESM
Module can now enable ESF Audit events only for particular users, groups, and resources.

• Improved interaction with LDAP client libraries resulting in fewer LDAP-related issues and easier
diagnostics - the Enterprise Server External Security Facility's MLDAP ESM Module has improved
interoperation with LDAP client libraries:

• The client library vendor and version information is logged after the library is loaded
• The module has better heuristics for loading the correct library supplied by the OS vendor, so the

"provider" configuration option can generally be omitted
• For OpenLDAP, the module sets its proprietary "connect timeout" option

• SNI support (requires 5.0 Patch Update 1 or later) - support has been added in Patch Update 1 for the
Server Name Identification (SNI) extension to TLS. This helps to avoid connectivity issues related to a
growing number of Web services being hosted on SNI servers.

Platform Support
Back to Top

Support is now available for the following additional or updated operating systems:

• SUSE (Power) 11 SP3, 12
• Red Hat (Power) 7.2, 7.3
• Windows Server 2019

For a full list of supported platforms, check HTTPS://SUPPORTLINE.MICROFOCUS.COM/
PRODAVAIL.ASPX.
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Significant Changes in Behavior or Usage
This section describes significant changes in behavior or usage. These changes could potentially affect the
behavior of existing applications or impact the way the tools are used.

Where present, the numbers that follow each issue are the Support Incident Numbers followed by the
Reported Problem Incident (RPI) number (in parentheses).

• Common Communications Interface
• Compiler
• Data Tools
• Documentation
• Enterprise Server
• Enterprise Server Auditing
• File Handling
• Micro Focus Directory Server
• MFCRYPTLIB
• Request Packet Interface API

Common Communications Interface

Back to the list

• Certificate subject names are now correctly checked against the name the client is attempting to
connect to. Certificates registered to "localhost" should now work as expected.

• The default Cipher Suites List now includes @SECLEVEL=0. This indicates that backwards
compatibility with old certificates such as MD5 is to be retained. As a result of this change, you need to
review your use of the Cipher Suites List and of any old certificates.

• If using Micro Focus Common Client(MFCC) or Micro Focus Communications Server(MFCS) to connect
to a non-existent remote host, it was possible to create a connection to a server listening on the same
port on the local system. This is no longer possible and a bad address error is reported in the error logs.

• By default, in this and previous releases an SSL/TLS CCI client can trust a server which resides on an
IP address that is not an intended connection target. You can now specify the ssl_only_verify_literally
option in your CCI.INI file to restrict the certificate check to improve security. See “CCITCP Security
Options in the CCI.INI File” in your product Help for more information. When connecting to a non-CCI
protocol server, all clients perform strict certificate checking as the new default behavior

Compiler

Back to the list

• The Search order has been updated, to allow the Compiler to find Java.

Data Tools

Back to the list

• Accessing a dataset through the Data File Editor now obtains a shared lock on Enterprise Server when
you open the file in shared mode.

3170479 (1115346)

Documentation

Back to the list

8 | Significant Changes in Behavior or Usage



• The ANIM Compiler directive has changed its default when compiling from the command line on
Windows platforms. The default is now ANIM. (Compiling from the IDE still defaults to ANIM.)

• The validation of server certificates for TLS (also known as SSL) connections has been corrected. This
is likely to cause connection failures in cases where previously connections were incorrectly allowed.
For example, if Fileshare is secured with TLS, client applications must be configured to use the
hostname of the Fileshare server as it appears in the server's certificate. If the Micro Focus Directory
Server is secured with TLS, then MFDS clients, such as the casstart command-line utility, will need to
connect to it using a hostname that appears in the certificate MFDS is using. (Note that a certificate can
contain multiple hostnames.) Consult your Certification Authority administrator for more information.

3192497 (1117068)

Enterprise Server

Back to the list

• A number of audit events now contain some additional information.

3140310 (1112666)

• Previously, the /x option of the CASRDTEX utility had been duplicated to drive XML output. This
prevented the export of transactions which was the original meaning of /x. To generate an XML export,
you must now specify the option /xm.

3180233 (1116108)
• casfhsf could hang when processing HSF files that contain records from tasks that ran in different

months.

3177385 (1115884)
• A new system transaction, CRCN, is now available to monitor the state of XA connections for each

resource manager (RM) entry defined in the system. CRCN is a replacement for the former XA
Reconnect facility that recycled SEPs on connection loss. The XA Reconnect facility was configured by
setting the ES_XA_RECONNECT environment variable. CRCN also uses this environment variable,
although its usage differs slightly. For more information see your product Help.

3174272 (1115727)
• On Windows, any casout and cassub messages are displayed on cassub and casout API invocation if

the environment variable ES_CAS_API is not set to "ON".

3160400 (1114458)

Enterprise Server Auditing

Back to the list

• Auditing on big-endian platforms now correctly interprets numeric audit data.

File Handling

Back to the list

• RELFORMAT=MF|RM is now enabled for FOLDER and other filename tags.

3164916 (1114803)
• The SORT-CONTROL special register is now supported during a SORT statement.

3159740 (1114389)
• To direct the handling of relative files to a particular file handler (either MF COBOL or RM/COBOL), use

the RELFORMAT=MF or RELFORMAT=RM configuration options within the [REL-DEFAULT] tag of the
EXTFH.CFG file. (The default is RELFORMAT=MF.)

3157247 (1114149)
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Micro Focus Directory Server

Back to the list

• The event codes for several MFDS audit points have changed.
• On Windows, by default, the Enterprise Server Administration Web interface can only be contacted

using the loopback address (localhost or 127.0.0.1). You can enable remote access to the Web
interface by turning off the loopback mode. See "Using the Loopback Address" in your product Help for
more information.

MFCRYPTLIB

Back to the list

• Passing an incorrect keyfile passphrase no longer results in receiving an RTS115 error in MFDS.

3181743 (1116186)

Request Packet Interface API

Back to the list

• The default behaviour for TLS certificate Common Name (CN) matching has changed for release 5.0. It
now requires a strict match on the CN value or any Subject Alternate Name (SAN). For example,
127.0.0.1 and localhost are no longer implicitly equivalent, nor are hostname and its IP address or fully-
qualified domain name (FQDN) variants. When starting a region from the Enterprise Server
Administration Web interface, a resolved IP address is used for the casstart -m parameter value. A
resolved IP address is also used even if a hostname is specified on a command line startup.

To change this behavior and use a resolved hostname value (as determined by the machine TCP
configuration, for example, hosts file entries.) set the environment variable MFDS_DNS_RESOLVE=Y.
To use an unresolved string literal hostname, for example, a value explicitly passed in via the casstart –
m command line parameter, set MFDS_DNS_RESOLVE=N.

3194613 (1117203)
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Known Issues
Refer to the Known Issues and Restrictions topic in the Product Information section of your product Help.
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Resolved Issues
The numbers that follow each issue are the Support Incident Numbers followed by the Reported Problem
Incident (RPI) number (in parentheses).

• Adis
• Codeset Support
• Data Tools
• Dialog System
• Documentation
• Embedded HTML Pre-Processor
• Enterprise Server
• File Handling
• Licensing
• Micro Focus Common Client
• Micro Focus Directory Server
• Micro Focus Server Administrator
• OpenSSL
• Run-Time System
• Setup
• SQL: COBSQL
• SQL: DB2
• SQL: OpenESQL
• SQL Option for DB2
• Web Service Client
• XML Support

Adis

Back to the list

• ERASE EOL no longer stops Keisen attributes being inherited when enabled by x"AF" function 81.

3169584 (1115178)
• ACCEPT LINE POSITION data-item, where data item has the JUST clause, now works as expected

when the ADISCF pre-clear option is selected.

3126794 (1111471)
• BLANK SCREEN BACKGROUND-COLOR n, where n > 7, now sets the intensity so that the bright

version of the color is used to fill the screen.

2856949 (1103978)

Codeset Support

Back to the list

• Conversions from ASCII to EBCDIC, with null data, no longer get corrupted.

3155499 (1114114)

Enterprise Server

Back to the list
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• There is no longer an issue with the order of file retrieval for the list of console logs affecting the
calculated maximum log number.

3192214 (1117023)
• LRECL fields are now displayed correctly in Data File Tools when accessing Enterprise Server hosted

data files.

3186524 (1116586)
• An issue with stopping printer terminals has now been resolved.

3185553 (1116498)
• MQ Security is now used when using DSNRLI.

3183523 (1116641)
• In Data Files Tools, the performance of opening a PO dataset that is hosted within Enterprise Server

has been improved.

3178780 (1116293)
• An issue that caused CTG requests using SNT users to be rejected has now been resolved.

3178729 (1115967)
• An issue with IBM PCOM was resulting in different colors in BMS in RUMBA and PCOMM. To work

around this, use the new environment variable ES_3270_REMOVE_NULL_COLOR_ATTRIB. Set
ES_3270_REMOVE_NULL_COLOR_ATTRIB to y or Y to prevent the color attribute set to null from
being sent in a 3270 flow.

3176924 (1115831)
• The MQ XA switch modules now supports the BATCHONLY option.

3173781 (1115552)
• Previously, xwbauth user exit was not invoked if URIMAP path was greater than 64 characters.

3173349 (1115514)
• When a region was configured to use Extended User Storage, the associated memory was not

registered with MFPM. This resulted in issues when using GETMAIN SHARED from a program
compiled with the AMODE directive.

3173307 (1115549)
• casout will no longer crash when using the /v option and there are more than 256 initiators/batch

printers/mprs.

Information for approximately 1300 processes can now be returned. If more than that exist, then casout
will return as much as it can and set return-code to 4.

This may be caused by schedulers using the entry point 'casout_getSEPS'. This can be called after
using the casout API with the /v option. The signature for this entry point is:

entry 'casout_getSEPS' using lk-casout-area.

lk-casout-area is defined in casbout.cpy but can only hold information for up to 256 processes. If there
are more than 256 processes then a call to this entry point will return truncated data (that is, 256
instances) and set return-code to 4.

Since casout /v can now return data for more than 256 processes, a new optional parameter, which is a
pointer, has been added to casout_getSEPS:

entry 'casout_getSEPS' using lk-casout-area lk-casout-user-area-ptr.

If there is data for more than 256 processes, then this pointer will be set to the address of the entire
block of data.

3171604 (1115376)
• Transaction routing requests from the same terminal to an ISC connected region involving a DPL

request to an APPC connected SYSTEM now execute successfully.
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3170073 (1115270)
• Transactions with a timeout that was running over midnight were timing out prematurely at midnight.

3169194 (1115144)
• Event manager exits that are enabled for SEP termination events are now invoked when a SEP, Initiator,

MPR or a printer is stopped cleanly (from ESMAC and casout) and not just when they are killed.

3168159 (1115051)
• The cursor position is now correctly identified when using floating maps - a map on top of another map.

3166543 (1114958)
• If created from a previous run, cas_ipcs.lst and cas_ps.lst will now be deleted at the next region startup.

3165807 (1114872)
• In a heavily loaded Enterprise Server cluster, it was possible for jobs to be dispatched to a printer

process instead of to a batch initiator. This would result in the job's lock being permanently held and
prevent further submission of jobs of that name.

3162806 (1116082)
• When Enterprise Server activates an LU62 connection to the mainframe or to another APPC linked

system, you can now leave the modename to SPACE. This indicates that the remote side of the APPC
connection should use an elected default modename.

3162296 (1114713)
• The position of a cursor on a map which size is different from that of the terminal size was incorrect.

This has been fixed.

3158745 (1114273)
• In an ESM secure region, when the userid field in a terminal definition was populated, there were issues

at region startup or when trying to install the TERMINAL resource.

3158468 (1115137)
• The environment variable ES_DDBG_PORT_RANGE now supports ports that include less than five

characters.

3158205 (1114237)
• With ES_XA_NB_RETRIES=-1 specified, Enterprise Server would leak SHM if the connection to the XA

RM was lost.

3158011 (1114246)
• An issue where a region would take too long to start up and eventually fail to start has been resolved.

3153774 (1113875)
• Return codes from file operations on the spool files are now displayed correctly when there is an error.

3153516 (1113882)
• When Data File Editor accesses files managed by an enterprise server region, users now need

UPDATE permissions in order to access the file exclusively.

3152798 (1113831)
• When connecting a TN3270 to an Enterprise Server instance, if the connection was lost, the printer

could not be reconnected. Now you can navigate back to ESMAC, then Clients, and stop the printer in
order to reconnect it after a loss of the connection.

3142113 (1112847)
• Formatting a trace that was captured during the period when the clocks went back an hour will now

format the entire trace. Previously, the formatter would exit at the point when the clocks changed.

2876312 (1106883)
• An issue with exporting PCT resources has been resolved.
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• Enterprise Server, LDAP-based security: The use of Active Directory groups, or other group classes
that specify membership using LDAP Distinguished Names, now works correctly when the "user ID
attribute" configuration option is also used.

3187284 (1116696)
• The Enterprise Server External Security Facility (ESF) now strips leading and trailing whitespace from

the user ID and other relevant fields in Verify (user authentication) requests.

3185569 (1116548)
• For Enterprise Server LDAP-based security, recent fixes to group processing exposed an issue when

multiple LDAP repositories are used and all-groups mode is enabled. This could cause some or all of a
user's group memberships to be disregarded, leading to incorrect denial of access to resources. The
problem has been corrected.

3182724 (1116269)
• Enterprise Server's MLDAP ESM Module now supports setting LDAP passwords using salted

SHA2-512 hashes. Otherwise known as the SSHA512 LDAP password type.

3178540 (1116077)
• In Enterprise Server with LDAP-based security where a security configuration uses two or more LDAP-

based Security Managers, and use-all-groups mode and group federation are enabled, in some cases
group membership was not processed correctly. Messages about "configured number of groups
exceeded" could be logged. This issue has been resolved.

3178071 (1115917)
• With certain Enterprise Server security configurations, the Data File Editor could display a "signon

failed" error when attempting to edit a dataset. This has now been fixed.

3177366 (1116022)
• The cache feature of the Enterprise Server External Security Facility now ignores some metadata when

comparing requests with cache entries. This is configurable. By default, the subsystem (CICS, JES,
etc.) and facility (terminal name, if any) are ignored. No ESM Modules supplied with the product use
that information in making security decisions. This significantly improves the cache hit rate and system
performance in some environments. See "Enabling and Configuring Caching" in the product
documentation for more information.

3172719 (1115513)
• When using LDAP-based security for Enterprise Server with an OpenLDAP-based provider (client)

library, the "connect timeout" setting now works correctly.

3172554 (1115522)
• When using Enterprise Server with LDAP-based security, it is now possible to specify an LDAP attribute

for user-group objects which specifies an alternative name for the group using the group short name
attribute. See "MLDAP ESM Module Custom Configuration Information" in your product Help for more
information.

3171437 (1115364)
• Enterprise Server LDAP-based external security no longer experiences a rare failure ("error code 7")

when verifying a user with advanced group processing options enabled.

3168197 (1115048)
• LDAP-based security for Enterprise Server could produce MD5 password hashes (using the

"mode=bind" and "password type=MD5" configuration option; note this is rarely used) which did not use
the canonical Base64 encoding. Some LDAP servers did not recognize these password verifiers,
resulting in sign-on failures after users changed their passwords. This has been fixed.

3162441 (1114843)
• In Enterprise Server, the MLDAP ESM Module now supports the short-to-long username mapping

option of the External Security Facility (ESF).

3160464 (1114394)
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• Enterprise Server now includes LDIF (LDAP Data Interchange Format) files suitable for configuring
LDAP-based security using the OpenLDAP server.

3147666 (1113475)
• Enterprise Server's optional LDAP-based security (External Security Facility with MLDAP ESM Module)

now supports the Microsoft "group" LDAP class, as used by Active Directory and AD/LDS. Consult the
online product Help or ask Micro Focus Customer Care for additional information.

3109881 (1110084)
• On Linux and UNIX platforms, the MLDAP ESM module in Enterprise Server LDAP-based security, by

default searches for an appropriate LDAP provider (client shared object) in the default locations used by
the OS vendor's preferred LDAP client package. It is also no longer necessary to specify the "provider"
option in a Security Manager configuration.

• An issue which resulted in the DELETE and DETAILS button staying disabled in the casrdo45 page has
now been fixed.

3181230 (1116351)
• Previously, when viewing cataloged datasets or Spool files in ESMAC, it was not possible to view any

lines beyond line 99,999. Now the limit for the START field in ESMAC has been increased to hold any
number up to 99,999,999.

3181032 (1116152)
• An RTS error 153 occurred when more than 6400 PCT entries were displayed in ESMAC. This has

been fixed.

3167388 (1115007)
• With some specific LDAP configurations there were problems with accessing datasets from ESMAC

where the configuration should have allowed access. This has now been fixed.

3167364 (1114989)
• The response time for catalog searches using 44 character strings in ESMAC has been improved.

3162969 (1114933)
• Remove locks is now enabled if the user has authorization in ESMAC.

3157534 (1114372)
• Deprecation of set-cookie meta tag in newer versions of some browsers such as Chrome or Microsoft

Edge caused issues with the cookies used by ESMAC. This has now been resolved.

3154175 (1113973)

• The esfadmin command-line utility now allows command-line and option-file parameters of any length,
up to the maximum command-line length of 8192 bytes. All esfadmin parameters can appear in the
option file except -o (which specifies the name of the option file).

2881372 (1107519)
• When using Enterprise Server with LDAP-based security, with two or more LDAP External Security

Managers, with the use-all-groups mode enabled, and with federation either enabled or in compatibility
mode (the default), it is no longer necessary to have a definition for each user in each LDAP ESM.
Specifically, once one LDAP ESM has identified the user, subsequent ESMs (those specified later in the
list of security managers) can specify additional groups for that user without having to define the user
again. For example, a security configuration specifies two LDAP security managers, LDAP-A and LDAP-
B. LDAP-A contains only user records. LDAP-B contains only group records and resource access rule
records. All-groups mode and federation are enabled. This configuration now works as expected.

2545079 (1081762)

• xa_open in the switch module now returns the correct return-code.

3171133 (1115386)
• The path of ESDB2XA switch module is not required in the environment variable LD_LIBRARY_PATH

when the application is compiled with XAID option and the dynamic switch module is used.
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3164301 (1114734)
• Within the DB2 LUW switch module, issues associated with ESLOGGING xa_open string parameter

have been addressed, and better handling of impersonated userid when using USERP has been
provided.

3156639 (1114209)

Data Tools

Back to the list

• The cursor is now visible in the free-text editing pane when the pane has focus whether it is in Shared
or Exclusive mode. The cursor position will start counting from column 1, rather than column 0 as well.

3154869 (1113954)
• On systems with a Japanese Locale, the Data File Tools utility no longer includes the phrase "Technical

Preview" in its title.

Dialog System

Back to the list

• An issue which prevented character mode Dialog System from recognizing ctrl-J and other key
combinations has been resolved.

3189921 (1116908)

Documentation

Back to the list

• Result precision has been added to the following built-in functions topics in the LRM: INDEX,
MAXLENGTH, SEARCH, SEARCHR, VERIFY, VERIFYR.

3183332 (1116336)
• The product help now includes a clarification in the topic "To run a native COBOL application from a

network server". It states that you must remove any individual copies of run-time system modules (for
example, cblrtsm.dll) that might have been copied into your application’s working directory. This is to
avoid issues with running the application such as "245 no valid licenses found" as the run-time system
is not loading from the expected location, or where the copied run-time modules are from other versions
of the product versions. Removing such modules ensures that any run-time system modules are only
loaded from the Enterprise Server instance installed on the server.

3176098 (1116309)
• The Software Requirement on UNIX topic in the docs and in the Release Notes now specifies that

SafeNet licensing requires that you have glibc-locale-32bit library installed on 64-bit machines.

3167672 (1115010)
• Depending on the environment, you need to export (UNIX) or set (Windows) environment variables in a

script. See “To specify environment variables for an application” for more information.

3164533 (1116625)
• The documentation now includes the instruction that when deploying a subset of Run-time System files,

you must include run.cfg in a sub-directory named 'etc'.

3160902 (1114441)
• When performing a sort that specifies more than one input file, you cannot specify one of those same

files as the output file unless it is the first input file specified.

3153333 (1113833)
• Details of how to use ILBOABN0 have been added to the documentation.

3148996 (1113634)
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• The documentation (in the COBOL Language Reference) has been updated to clarify the use of the
OPTIONAL keyword, and the use of (managed) optional parameters within the Procedure Division
Header.

2883545 (1107792)
• The National Locale Support (NLS) Library Routines section of the documentation now contains all

available NLS routines.
• The Significant Changes in Behavior section of the documentation now includes the default change for

FASTINIT. (This change occurred in version 3.0, as stated in the release notes on release.)
• The documentation has been improved for the CBL_LOCATE_FILE library routine concerning the use of

space- and null-terminated strings.
• The Rebuild syntax differs between UNIX and Windows platforms. For any of the Rebuild options, UNIX

platforms use a hyphen (-) prefix before the letter, and Windows platforms use a forward-slash (/) before
the letter.

• The recommended method of high availability for VSAM files in Enterprise Server is to use standalone
Fileshare. The documentation has been changed to reflect this.

• The documentation has been updated to reflect that 'DEFAULT' is a reserved word when running under
an ENTCOBOL dialect.

• In the documentation, the code example given in the 'Thread-specific Data Handling Routines' topic
now compiles cleanly.

• The called program search order, as documented in the 'Backward Compatibility' section of the
documentation, has been corrected for Windows platforms.

• The parameter definition for OOCTRL"+/-W" has been clarified in the documentation.
• The documentation now contains a topic - Using a File Handler in JVM COBOL - detailing how to

manually configure the File Handler that a JVM COBOL project uses.

• A link to the IBM documentation added to the 'DSNRLI Functions used for RRSAF' topic - this is to
enable you to locate full details on required parameters, and to give examples of its use.

3184952 (1116524)
• The documentation now states that the section heading when adding environment variables through the

Enterprise Server UI is case sensitive.

3177135 (1115979)
• The documentation explaining the scope for the HOST-NUMCOMPARE directive has been simplified.

3156368 (1114075)
• The "To specify the location of application files" topic has been updated to clarify the location of IMS

copybooks.

3111136 (1109993)
• Documentation for all Java API classes is now provided in HTML format and contained in an archive file

located by default in the %ProgramFiles(x86)%\Micro Focus\<product name>\javaee-ccl\docs directory.
See the Java API Classes topic in your product documentation for details.

3109273 (1109725)
• Documentation for all Java API classes is now provided in HTML format and contained in an archive file

located by default in the %ProgramFiles(x86)%\Micro Focus\<product name>\javaee-ccl\docs directory.
See the Java API Classes topic in your product documentation for details.

3109271 (1109724)
• The sample code listed in the CBL_DIR_SCAN_READ documentation has been formatted to enable

you to copy and paste the code, ready for compilation.
• The sample in the documentation on 'Using FHRedir and an allocation override rule' has been corrected

to show the spool filenames in their correct case (upper case).
• The documentation now includes a definition for the system abend code S913 (which is "Security

Violation - the user is not permitted to access the resource").
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Embedded HTML Pre-Processor

Back to the list

• An issue that caused the embedded HTML preprocessor to display incorrect banner information has
been corrected.

3160255 (1114437)

File Handling

Back to the list

• Warning messages when checking disk space for Fileshare advanced logging are now only displayed
when necessary. Previously, a disk space warning was given even if sufficient space was available.

3174510 (1116078)
• A Fileshare server shutdown no longer leaves files opened or users remaining logged on.

2837526 (1108076)

• CFLE updating large record no longer results in an RTS252 error with the HA-VSAM configuration.

3167973 (1115057)
• You will no longer receive an RTS114 error when a failing primary node is restarted and attempts to re-

join the HA group (as a standby node), as long as it closed all files successfully before the failure.

3159872 (1114360)

• Rollback recovery will no longer hang when processing a bad log entry during a scan of the transaction
log file.

3168055 (1115049)

• A new MFJSORT option allows input LSEQ files to be treated as FB through setting the environment
variable MFJSLSEQFB=ON.

3190089 (1116876)
• SORT operations no longer compare field data that is outside of the current record length.

3187044 (1116633)
• MFJSORT now ignores the RECORD TYPE value if the SORTIN dataset is non-VSAM.

3163293 (1114669)
• During a SORT, the SUM statement now correctly handles 8-bytes BI fields.

3161349 (1114540)
• An internal SORT program no longer returns a COBRT252 error for cataloged files when being

compiled with AMODE"31" and dialect"entcobol".

3161100 (1114586)
• SORT no longer produces an RTS114 error when both outfil and sortout datasets are not defined.

3154290 (1113901)
• MFJSORT now correctly honors MFJ_INPUTDS_ERROR=N on missing physical concatenated

datasets.

3153313 (1113826)
• MFJSORT OUTREC now applies the correct length for EDIT patterns.

3145526 (1113484)

Licensing

Back to the list
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• cesadmintool.sh now searches for " version" string in the Java version and ignores any additional output
that might appear.

3185425 (1116559)
• In Docker environments, the license administration program, MFLicenseAdmin, now copes with longer-

than-usual license strings. These occur with longer pieces of customer information embedded in the
license.

3174371 (1115634)
• There is no longer an entry in the Uninstall column for licenses installed on remote machines.

3131570 (1112101)

Micro Focus Common Client

Back to the list

• Applications which use the Micro Focus Common Client (MFCC), such as the Interface Mapping Toolkit
(when deploying a COBOL web service or EJB to Enterprise Server), can now specify credentials when
binding to the Micro Focus Directory Server. This provides additional security. If credentials are not
configured, MFCC will use an anonymous bind, as it did in earlier product versions. Credentials are
specified using the mf-client.dat configuration file.

Micro Focus Directory Server

Back to the list

• The Enterprise Server Administration Web UI will only display user session details if the logged in user
is authorized.

3190235 (1116886)
• Additional Enterprise Server Administration Web UI server-side checks were added to guard against

non-editable field value changes for started Enterprise Server instances and active security
configurations.

3185626 (1116719)
• Establishing a connection to a TLS-enabled MFDS process if non-default (non-DemoCA) certificates

were used now works as expected.

3174276 (1115675)
• The MFDS journal data format has been enhanced to be platform and bitism independent.

3169565 (1115249)
• Improved validation of data input to Enterprise Server Administration Web UI.

3163386 (1114693)
• Adding or editing TCP listener-requested endpoint values using the Enterprise Server Administration

web UI so that a port clash may occur now gives a warning rather than being disallowed and treated as
a user input error.

• If the Enterprise Server Administration Web UI is hosted in a Docker container, the displayed hyperlinks
to reach the Micro Focus Communications Process web pages can now be configured to use an
address which is valid outside the container.

• URLs to SSL-enabled MFCS Control Channel addresses displayed in the Enterprise Server
Administration HTML UI now use an https prefix.

• A new field, "Server CA Root Certificate", is available in the Communications Process Control Channel
page (id: c400). The value specified here is used unless the MFDS_server_CAROOT environment
variable was specified as it takes precedence. You must specify the server CA root certificate if the
Communications Process Control Channel is SSL/TLS-enabled and if communications with the MFDS
process are required such as to respond to keepalive and any other administration control requests.

• Enterprise Server Administration Web UI would sometimes display the successful logon splash screen
instead of a logon error message.
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• The MFDS process could terminate when copying the definition of an Enterprise Server instance if it
contained a very long description text.

• Trying to view or edit the properties of a Security Manager that is not in the Directory Server Security
Manager list now results in receiving an appropriate warning message instead of an HTTP 404 error.

• MFDS now saves any changes made to the Communications Process immediately instead of at
shutdown.

Micro Focus Server Administrator

Back to the list

• If Enterprise Server Administration was set to restricted access, some MQ listener configuration pages
would not be displayed.

3152874 (1113782)
• The Enterprise Server Administration HTML UI no longer displays the IP address but only the host

name used by the Web administration server process.

3140974 (1112912)

OpenSSL

Back to the list

• Visual COBOL, Enterprise Server, and Enterprise Developer now include an updated collection of
public Certification Authority root and intermediate certificates (CARootCerts.pem) derived from the
public collection maintained by Mozilla.org.

Run-Time System

Back to the list

• Under certain circumstances, if a file was opened multiple times and an error occurred, then any
physical locks on the file could be lost.

3177819 (1116043)
• In a threaded environment, when using critical-sections and simultaneously loading/unloading shared-

objects, a race condition would sometimes create a deadlock. This no longer occurs.

3177711 (1116154)
• The use of the P(COBSQL) Compiler directive in a Visual Studio or Eclipse project no longer causes the

IDE to crash intermittently at termination.

3133807 (1112077)
• The COBRT243 Class could not be loaded error message now contains the name of the class that

could not be found.

3104988 (1109420)
• Calls to CBL_MEM_VALIDATE might not have given the full memory corruption details if the corruption

occurred in freed memory. This is now fixed.
• When using the Character Animator, you can enter Ctrl+C to interrupt the running process you are

debugging. This would sometimes fail to stop the running process, but should now behave as expected.

• When setting the out-length parameter of the CBL_STRING_CONVERT API to zero in order to get the
size of the buffer required for the conversion, the API no longer fails with a ArgumentNullException
when running on the .NET environment. Under JVM COBOL, this API no longer corrupts the output
buffer if the output length has been set to 0.

• In managed COBOL, for a very small set of cases for exponentiation and DIVIDE ROUNDED,
performance was very poor. Also, for some of this set of cases, the result of DIVIDE ROUNDED could
round in the wrong direction. These issues have been fixed.
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3185807 (1116589)
• Within JVM COBOL, a MOVE operation from a COMP-2 item containing a negative value to an

unsigned COMP-5 item now gives the correct result.

3175547 (1115719)
• Under JVM COBOL, RunUnit GetEnvironmentVariable() is now case insensitive on look-up of

environment names.

3161925 (1114545)
• CALL "SYSTEM" in a JVM COBOL program that is executed from a run unit in Java no longer produces

a COBRT200 error if RunUnitStartupOptions.UseSingleThreadedRuntime is set.

3151448 (1114573)
• JVM COBOL only. An issue has been resolved whereby some arithmetic expressions using a binary

item (COMP, COMP-5) that had the value -2147483648 ( - 2**31 ) could result in stack overflow.

Setup Issues

Back to the list

• The Data File Tools AddPack can now be installed alongside Enterprise Server.

3158290 (1114230)
• The installer error handling has been extended to cater for certain conditions.

3152023 (1113706)

SQL: COBSQL

Back to the list

• COBSQL now handles "ELSE EXEC SQL" correctly when it is all on the same line in the source file.

3176046 (1115778)
• The XAID option did not work properly for COBSQL when CHARSET(EBCDIC) was used.

3174070 (1115697)
• A compilation error that was caused by the COBSQL preprocessor incorrectly handing sections

declared inside of a copybook has been fixed.

3164533 (1116863)
• An unreadable copybook caused COBSQL to loop when stacked with the CP preprocessor. This has

been fixed.

3156374 (1114103)
• An unreadable copybook caused COBSQL to loop when stacked with the CP preprocessor. This has

been fixed.

3156374 (637041)
• An issue that caused a compilation error when COBSQL encountered inline comments in an EXEC

SQL statement has been fixed.

3123025 (1111044)
• COBSQL messages have been updated to provide more information when failure is due to a missing list

file, and when the list file is missing due to use of the LTYPE=NONE directive.

2883514 (624749)
• To prevent exceeding the COBSQL directive buffer size, the maximum directive buffer size has been

increased to a maximum of 8000 characters.

2852872 (1104084)
• To prevent hanging or a compilation error, COBSQL has been updated to properly handle conditional

statements in the same line as EXEC SQL statements.
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2804004 (1097225)
• An issue that sometimes caused SQL error text to display as truncated on the command line has been

fixed by increasing the maximum error length to 250 characters, and updating the logic used to
construct the message.

• An issue that caused an error when a space was present between an END-EXEC statement and a
period has been fixed.

• The COBSQL precompiler interprets the SOURCETABSTOP COBOL compiler directive as
SOURCETABSTOP(8) in all cases. This is due to Pro*COBOL honoring only SOURCETABSTOP(8),
and is a permanent restriction for COBSQL.

SQL: DB2

Back to the list

• An optional 'FROM' keyword in SQL statements such as 'FETCH FROM <cursor-name>' used to cause
compiler errors.

3191635 (1116976)
• There is no longer an issue with negative line numbers being generated in the .bnd file when the

COBOL source file has more than 32700 lines of code.

3188178 (1116814)
• An issue with the DB2 preprocessor caused it to incorrectly classify PL/I variables greater than 4000

bytes as LONG VARCHAR when it should have classified PL/I variables less than 32767 bytes as
VARCHAR as it does for COBOL variables. This has been fixed.

3185976 (1116539)
• DB2 XA switch source is now shipped for Linux ppc64le platforms.

3184287 (1116424)
• The DB2 pre-compiler incorrectly generated a compile error when hyphen was used in SQL command

without a space between the hyphen and host variable name. This has now been fixed.

3180089 (1116102)
• DB2 LUW now supports dashes in cursor names, so the DB2 pre-compiler no longer changes dashes

to underscores in cursor names.

3177271 (1115912)
• The DB2 pre-compiler incorrectly passed COBOL variable names to PL/I programs when generating

code to handle EXEC SQL SET CURRENT PACKAGE PATH statements.

3175885 (1115744)
• The DB2 and OpenESQL pre-compilers now qualify generated code that uses SQLSTATE to qualify

SQLSTATE similar to this one: SQLCA.SQLSTATE.

3173295 (1115512)
• An issue that caused the DB2 preprocessor to incorrectly reject FILLER as a valid host variable name in

PL/I programs has been fixed.

3164600 (1114767)
• An issue that occurred with user personalization on user names exactly eight characters long has been

resolved.

3156639 (1114163)
• When a DBCS database is used with CHARSET(EBCDIC), the data of a char field following a varchar

field will no longer be corrupted.

3155499 (1114065)

SQL: OpenESQL

Back to the list
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• JDBC now returns SQLCODE=+1 when the fetched value is NULL and NULL indicator is not used.

3191192 (1116953)
• Decimal value is now inserted correctly into Oracle DB when DECDEL=COMMA is set.

3189836 (1116947)
• An issue that caused performance degradation when using a STATIC cursor has been fixed.

3185894 (1116518)
• The OpenESQL run-time now handles the compiler directive SQL(NOAUTOFETCH) correctly.

3177780 (1115994)
• OpenESQL has been updated to provide cobrhcedsn64.so for 64-bit only platforms.

3174065 (1116801)
• HCOSS now accepts FOR READ ONLY clauses in cursors before FETCH FIRST clauses. This is

undocumented behavior for DB2 z/OS but HCOSS now supports it to ensure mainframe compatibility.

3173586 (1115528)
• An issue where WITH HOLD cursors could remain open after an IMS transaction had terminated for

SQL Server, ODBC and PostgreSQL XA resources has been fixed. SQL(NOCHECKDUPCURSOR) can
now be used to override duplicate cursor checking when SQL(DIALECT=MAINFRAME) is used.

3172382 (1115430)
• A new SQL directive [NO]ALLOWSERVERSELECT supports server-specific SELECT statements that

are not recognized by OpenESQL as valid ESQL SELECT ... INTO statements. This behavior was the
default in Net Express.

3165092 (1114866)
• An issue that caused the OpenESQL runtime to incorrectly handle binary parameter markers for PIC

X(n) VARYING host variables has been fixed.

3163759 (1114719)
• The SQL Directives dialog box that appeared for .NET project types in the Visual Studio IDE

erroneously omitted the SQL(HSFTRACE) option for DBMAN=ADO. This has been fixed.

3162428 (1114593)
• Data type information that was incorrectly mapped by the OpenESQL Assistant caused it to display

column information improperly when using an IBM DB2 ADO.NET provider connected to a DB2 z/OS
data source. This has been corrected.

3161285 (1114478)
• An issue that occurred when the SQL BEHAVIOR compiler directive option was set to UNOPTIMIZED

caused the OpenESQL runtime to generate an RTS 114 error when the COBOL application exited. This
has been fixed.

3158065 (1114288)
• Problems with SQL Server and PostgreSQL that surfaced when working with large binary columns have

been fixed.

3156215 (1114335)
• An issue that caused the OpenESQL preprocessor to generate an incorrect error message when

SQL(DBRMLIB) was not set prior to specifying SQL(VERSION) has been fixed; the OpenESQL
preprocessor now generates the correct error message.

3155275 (1114004)
• SQL FETCH ABSOLUTE CURSOR was not returning rows. A COMP position value is now supported in

the SQL FETCH ABSOLUTE/RELATIVE statement and it behaves as expected.

3153738 (1113903)
• An issue that prevented HCOSS from correctly handing IS [NOT] DISTINCT predicates has been fixed.

3152630 (1113764)
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• An issue that caused HCOSS to incorrectly apply QUALIFIERs to common table expression names has
been fixed.

3152008 (1113714)
• The DSNRLI function SWITCH TO is now supported for Enterprise Server Mainframe Subsystem

applications using DB2, Microsoft SQL Server, and PostgreSQL.

3151779 (1113680)
• An issue that caused HCOSS to incorrectly handle FETCH FIRST ROW ONLY when no literal row

count was present has been fixed.

3151398 (1113734)
• An issue that caused the OpenESQL runtime to execute a core dump on exit when the

MEMORY_STRATEGY tunable was set has been fixed.

3142107 (1113077)
• A program that contained zoned decimal host variables used in SQL statements and compiled using

charset(EBCDIC) and dialect(MF) sometimes caused a run-time error. This has been corrected.

SQL Option for DB2

Back to the list

• The XDB pre-compiler incorrectly generated line and column number information used by the IDE to get
COBOL information about field on EXEC SQL INSERT statements.

3182574 (1116350)
• The XDB pre-compiler incorrectly tried to generate interface logic in nested COBOL routines without

checking if a SQLCA copybook was defined. This resulted in an "Undefined ECM error" error message.
This has been fixed.

3168445 (1115099)

• An issue caused by an uninitialized stack variable that resulted in a server violation has been fixed.

3168714 (1115237)

• A number of XDB components have been enhanced to better implement bulk INSERT/UPDATE/
MERGE statements using both local XDB engines and XDB Link in dynamic and static mode to z/OS
DB2.

3175084 (1115695)
• XDB Link has been updated to support the invocation of stored procedures that return multiple result

sets on z/OS DB2.

3168036 (1115315)

• A memory leak in DRDA Continue Query Reply Message processing has been fixed.

3160580 (1114426)

• An issue that prevented XDB Server configuration from allowing the full length of 16 characters in the
Global Security Location text box has been fixed.

3168821 (1115106)
• An issue with SQL step processing related to CASE expression evaluation that caused the SQL

COALESCE scalar function to return the wrong result has been fixed.

3160595 (1114413)
• Support has been added for the SOUNDEX() and DIFFERENCE() scalar functions.

3155733 (1114043)
• An issue that caused a buffer overflow when processing a very large UPDATE WHERE CURRENT OF

in the XDB Link has been resolved.
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3151725 (1113807)
• An problem with XUTLB (XDB emulation of DSNUTILB) erroneously reporting an invalid isolation level

has been resolved.

3134586 (1112183)
• An issue with join optimization using differing lengths of DECIMAL data has been resolved.

3131870 (1111903)
• An issue with a scalar query using a DATETIME value returning an error indicating that the value was

invalid has been resolved.

3129637 (1111872)
• An issue with Query Descriptor mapping when performing XDB Server to Server connectivity has been

fixed.

3112564 (1110514)
• An issue with an uninitialized stack space causing a thread abend in XDB SQLDA code page

processing has been fixed.

2990360 (1108708)

Web Service Client

Back to the list

• When a generated Web service client executes, an additional optional user-supplied exit program, exit-
http-resp-headers, is now called to provide access to any and all HTTP headers present in the response
message from the service.

3172598 (1115452)

XML Support

Back to the list

• XML PARSE now handles "WITH ENCODING" clauses correctly.

3175231 (1115707)
• Data within the CDATA tag is now processed by the managed XML syntax support run-time.

3166588 (1114954)
• XML PARSE did not handle lengthy CONTENT-CHARACTERS correctly which caused the event to be

returned twice.

3162231 (1114582)
• Literals positioned beyond column 72 in the editor are now being handled correctly and compile without

any issues.

3152550 (1114087)
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Other Issues Resolved in This Release
The numbers listed are the Support Incident Numbers followed by the Reported Problem Incident (RPI)
number (in parentheses).

• 3177187 (1115851)
• 3181887 (1116201)
• 3177661 (1116118)
• 3134735 (1112201)
• 3170148 (1115245)
• 3171080 (1115373)
• 3161109 (1114775)
• 3160774 (1114530)
• 3187599 (1116668)
• 3176925 (1115833)
• 2802311 (1097060)
• 3140337 (1112673)
• 3175137 (1115685)
• 3170946 (1115402)
• 3128586 (1111526)
• 3105876 (1109394)
• 2990180 (1108737)
• 2854004 (1103682)
• 2851622 (1103230)
• 2844942 (1102368)
• 2841043 (1102369)
• 2590883 (1085717)
• 3181941 (1116211)
• 3103315 (1109252)
• 2990950 (1108778)
• 2865338 (1105207)
• 2597474 (1088223)
• 3164898 (1114811)
• 3150507 (1113583)
• 3122080 (1110968)
• 3122020 (1110949)
• 3114654 (1110269)
• 2887726 (1108356)
• 2885799 (1108108)
• 2873642 (1106416)
• 2835954 (1101265)
• 2795293 (1096771)
• 2652488 (1090826)
• 2587952 (1086146)
• 3123593 (1111108)
• 2642528 (1090004)
• 2594601 (1086032)
• 3181445 (1116188)
• 3168020 (1115032)
• 3164533 (1115215)
• 3162064 (1114546)

• 3158311 (1114231)
• 3158072 (1114399)
• 3141381 (1112770)
• 3164533 (1115570)
• 3193749 (1117140)
• 3158936 (1114346)
• 3156405 (1114097)
• 3152246 (1113749)
• 3157702 (1114217)
• 3157956 (1114290)
• 3127953 (1111577)
• 3159456 (1114310)
• 2867519 (1105516)
• 3191105 (1116958)
• 3174042 (1115569)
• 3176098 (1115962)
• 3172981 (1115501)
• 3127698 (1111446)
• 3189442 (1116934)
• 3188582 (1116744)
• 3178509 (1115958)
• 3160759 (1114427)
• 3150188 (1113906)
• 3177187 (1115851)
• 3181887 (1116201)
• 3177661 (1116118)
• 3134735 (1112201)
• 3170148 (1115245)
• 3171080 (1115373)
• 3161109 (1114775)
• 3160774 (1114530)
• 3187599 (1116668)
• 3176925 (1115833)
• 2802311 (1097060)
• 3140337 (1112673)
• 3175137 (1115685)
• 3170946 (1115402)
• 3128586 (1111526)
• 3105876 (1109394)
• 2990180 (1108737)
• 2854004 (1103682)
• 2851622 (1103230)
• 2844942 (1102368)
• 2841043 (1102369)
• 2590883 (1085717)
• 3181941 (1116211)

• 2990950 (1108778)
• 2865338 (1105207)
• 2597474 (1088223)
• 3164898 (1114811)
• 3150507 (1113583)
• 3122080 (1110968)
• 3122020 (1110949)
• 3114654 (1110269)
• 2887726 (1108356)
• 2885799 (1108108)
• 2873642 (1106416)
• 2835954 (1101265)
• 2795293 (1096771)
• 2652488 (1090826)
• 2587952 (1086146)
• 3123593 (1111108)
• 2642528 (1090004)
• 2594601 (1086032)
• 3181445 (1116188)
• 3168020 (1115032)
• 3164533 (1115215)
• 3162064 (1114546)
• 3161964 (1114569)
• 3158311 (1114231)
• 3158072 (1114399)
• 3141381 (1112770)
• 3164533 (1115570)
• 3193749 (1117140)
• 3158936 (1114346)
• 3156405 (1114097)
• 3152246 (1113749)
• 3157702 (1114217)
• 3157956 (1114290)
• 3127953 (1111577)
• 3159456 (1114310)
• 2867519 (1105516)
• 3191105 (1116958)
• 3174042 (1115569)
• 3176098 (1115962)
• 3172981 (1115501)
• 3127698 (1111446)
• 3189442 (1116934)
• 3188582 (1116744)
• 3178509 (1115958)
• 3160759 (1114427)
• 3150188 (1113906)
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• 3161964 (1114569)
• 3172126 (1115445)

• 3103315 (1109252) • 3187219 (1116640)
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Unsupported Functionality
This section includes information about features or functionality that are no longer supported.

• The HOSTSIGNS Compiler directive is no longer supported. Micro Focus recommends that you use the
following Compiler directives instead: SIGN-FIXUP, HOST-NUMMOVE, and HOST-NUMCOMPARE.
This is a change since version 3.0 of this product.
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Installation

Before Installing

Downloading the Product
1. Use the download links in your Electronic Product Delivery email.

For more information follow the links for the installation instructions and the End User License
Agreement.

On Windows

System Requirements

Hardware Requirements

The disk space requirements are approximately:

COBOL Server

800MB

Note: This includes the space needed to cache information locally so that you can modify the
installation without the original source media.

Operating Systems Supported

For a list of the supported operating systems, check the Product Availability section on the Micro Focus
SupportLine Web site: http://supportline.microfocus.com/prodavail.aspx.

• Support for development on Windows 8 and Windows Server 2012 has been discontinued. These
platforms are still supported for deployment. Windows 8.1 and Windows Server 2012 R2 are supported.

Software Requirements

Note:

• The setup file will check your machine for whether the prerequisite software is installed and will
install any missing prerequisites and the product components.

• This product includes OpenSSL version 1.1.1b.

Before installing this product, you must have the following software installed on your computer:

• The Microsoft .NET Framework - the setup file installs the .NET Framework 4.5.2 . You might need to
install the following version of the .NET framework manually, if it is targeted by your applications:

• Microsoft .NET Framework 2 - if your applications use the ILCLR(2) Compiler Directive or if they
target the .NET Framework versions 2, 3 or 3.5. You might need to download these installers
depending on the .NET Framework you are targeting.

To download the Microsoft .NET Framework 2 click here.
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Microsoft .NET Framework 2 or later is also required for the Micro Focus License Manager if you
install this on a separate machine as a license server.

Note:

• .NET Framework 3 is provided with Windows Vista and Windows Server 2008.
• .NET Framework 3.5 is provided with Windows 7 and Windows Server 2008 R2.
• .NET Framework 4.0 is provided with Windows 7 and Windows Server 2008 R2.
• .NET Framework 4.5 is provided with Windows 8 and Windows Server 2012.
• .NET Framework 4.5.1 is provided with Windows 8.1 and Windows Server 2012 R2.
• .NET Framework 4.6.2 is provided with Windows 10 and Windows Server 2016.

• Microsoft's Web Platform Installer 2.0 if your application targets ASP.NET 4. This installs and sets up
ASP.NET. To download the installer click here.

• A Web browser is required for Enterprise Server Administration in COBOL Server.

To use your Web browser offline, you need the dial-up networking feature of Windows installed.
Otherwise you might have TCP/IP errors such as being unable find "localhost" or the numeric equivalent
(127.0.0.1).

• To use Enterprise Server Administration, scripting or JavaScript support must be enabled in your
browser. This is on by default in Internet Explorer in most Windows operating systems, apart from
Windows Server 2003. Also, active content must be allowed and not blocked. To enable both these in
Internet Explorer:

1. Click Tools > Internet Options.
2. On the Security tab, click Custom Level. In the Scripting section, under Active Scripting, click

Enable.
3. On the Advanced tab, scroll down the list to the Security section, and ensure the item Allow active

content to run in files on My Computer is checked.
• Enterprise Server Help requires the Java Runtime Environment on some Windows systems to enable

the Search facility to work.

Important: For local servers, you do not need to install the Micro Focus License Administration tool
separately, as the setup file installs a new Visual COBOL client and a new licensing server on the
same machine.

If you have a network server, you must update the license server before installing the product as the
client is not able to communicate with license servers of versions older than 10000.2.660. On
Windows, you can check the version of your license server by clicking Help > About in the Micro
Focus License Administration tool. To check the version of the license server on UNIX, run /var/
microfocuslicensing/bin/mfcesver or /var/microfocuslicensing/bin/
cesadmintool.sh.

If Micro Focus License Manager version 10000.2.02070 or older is installed, it must be uninstalled
before the product installation or upgrade can continue.

You can download the new version of the license server software from the Micro Focus SupportLine
Web site: http://supportline.microfocus.com.

Additional Software Requirements

To ensure full functionality for some COBOL Server features, you might be required to obtain and install
additional third-party software in addition to the prerequisite software installed automatically by the COBOL
Server setup file.

Click here to see this information on the Product Documentation pages on Micro Focus SupportLine.

Installation Restrictions and Requirements
Before starting the installation, you should consider the following:
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• You need to be logged in with a user-ID that has write access to the registry structure under
HKEY_LOCAL_MACHINE, HKEY_CLASSES_ROOT, and HKEY_CURRENT_USER so the installation
software can set the environment appropriately. You also need to be logged on with Administrator
privileges.

• Before installing this product, make sure that any existing Micro Focus Directory Server (MFDS) or
CCITCP2 Windows service (on Windows) or a process (on UNIX) from an existing product is stopped
and uninstalled. On Windows, do this as follows:

1. Stop the MFDS and CCITCP2, using either the Windows Service Management Console GUI
(services.msc) or from a command line prompt by typing:

net stop mf_ccitcp2

Only one instance of the MFDS or CCITCP2 service can run on a Windows machine.
2. Uninstall the MFDS or CCITCP2 service.

For MFDS, from a command line prompt enter: mfds -u

For CCITCP2: ccitcp2 -u

To run an earlier version of MFDS as a service after you have installed a later version:

1. Stop and uninstall the MFDS service, as described above.
2. Reinstall the earlier version, as follows:

a. Open a  COBOL Server command prompt.
b. Install the service. Enter the following command: mfds -i
c. Start the service. Enter the following command: net start mf_ccitcp2

Note: The two versions use different paths for environment and registry values, so the list of
configured enterprise servers might be different depending on which version has been started,
since, by default, different MFDS data repositories are used.

MFDS 5.1 and later are able to import or use Enterprise Server configuration data generated by earlier
versions of MFDS, but 5.0 or earlier versions of MFDS might not be able to read data generated by later
versions.

It is possible to run MFDS from a command prompt ("mfds") rather than as a service, but by default the
"mfcobol" port is used (86) and this can only be used by one process at a time

Product Co-Existence
Note: The following applies to Windows only.

• Visual COBOL and COBOL Server cannot coexist on the same machine.

On UNIX

System Requirements

Hardware Requirements

The disk space requirements are approximately:
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Platform Installer type Setup

file size

Disk space

required for

the installation

Disk space

required for

running

the product

Sentinel RMS

license server

POWER
running AIX

Micro Focus 398 MB 1.59 GB 796 MB 41 MB

HP IA Micro Focus 764 MB 3.13 GB 1.53 GB 79 MB

System Z
running Red Hat
Linux

Micro Focus 319 MB 1.28 GB 638 MB 39 MB

x86-64 running
Red Hat Linux

Micro Focus 393 MB 1.57 GB 786 MB 50 MB

ppc64le running
Red Hat Linux

Micro Focus 211 MB 844 MB 422 MB 1 MB

SPARC running
Solaris

Micro Focus 392 MB 1.57 GB 784 MB 41 MB

x86-64 running
Solaris

Micro Focus 368 MB 1.47 GB 736 MB 33 MB

System Z
running SUSE
SLES

Micro Focus 224 MB 896 MB 448 MB 39 MB

x64 running
SUSE SLES

Micro Focus 277 MB 1.11 GB 554 MB 50 MB

ppc64le running
SUSE SLES

Micro Focus 191 MB 764 MB 382 MB 1 MB

Operating Systems Supported

For a list of the supported operating systems, check the Product Availability section on the Micro Focus
SupportLine Web site: http://supportline.microfocus.com/prodavail.aspx.

Software Requirements

Note: This product includes OpenSSL version 1.1.1b.

Before installing this product, you must have the following software installed on your computer:

• The "ed", "sed" and "tar" utilities must be installed and added to the PATH.
• The pax archiving utility is required by the setup file. Pax is distributed with most UNIX/Linux systems

but, if it is missing, you must install it separately. To verify pax is installed, run pax --help or pax --
version at the command line.

• Required libraries for Red Hat and SUSE Linux platforms - The installer checks that both the 32-bit and
64-bit libraries listed below are installed on both 32-bit and on 64-bit Operating Systems for this product
to install and work correctly.

If installing on a 64-bit OS, the 32-bit libraries are not installed by default and must be installed before
you start the installation.
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Library 32-bit
Library
Name

64-bit
Library
Name

Platform

s390 SUSE 12¹ Red Hat 6.x Red Hat 7

glibc glibc-*.i686 glibc-
*.x86_64

glibc-*.s390 X X

libgcc libgcc-*.i686 libgcc-
*.x86_64

libgcc-*.s390 X X

libstdc++ libstdc++-
*.i686

libstdc++-
*.x86_64

libstdc++-
*.s390

X X

Visit the Red Hat Web site for more information.

¹ On SUSE 12, you can only install the 64-bit version of this product. The glibc-locale-32bit library is still
required by the SafeNet Sentinel licensed components.

• Java 8 (32 or 64-bit versions), and Java 11 (64-bit version only) are supported for executing JVM
COBOL code and for native COBOL and Java interoperability. You can download AdoptOpenJDK's
OpenJDK 8 with Hotspot from AdoptOpenJDK's Web site and unpack the archive anywhere on your
machine.

Note:

• On AIX and zLinux, you need to have IBM's JDK. The earliest supported release of IBM's JDK
is 7.0 Service Refresh 8. If you install IBM's JDK 8, on AIX you must install its latest fix - JDK 8
SR5 FP16. You can get IBM's AIX JDK from IBM's Web site.

• On HP-UX, you need to have HP-UX JDK. The earliest supported release of HP-UX is JDK
7.0.11. You can get the HP-UX Java JDK from HP's Web site.

• On Solaris platforms (both SPARC and Intel) only the 64-bit version of Java 8 and later is
supported.

Before you start the installation, you need to set the environment as follows:

• You need to set the LANG environment variable to pick up localized messages. The LANG settings are
English and Japanese only.

• JavaScript or scripting support must be enabled in your browser, so that Enterprise Server
Administration is usable. Also, active content must be allowed and not blocked.

Important: For local servers, you do not need to install the Micro Focus License Administration tool
separately, as the setup file installs a new Visual COBOL client and a new licensing server on the
same machine.

If you have a network server, you must update the license server before installing the product as the
client is not able to communicate with license servers of versions older than 10000.2.660. On
Windows, you can check the version of your license server by clicking Help > About in the Micro
Focus License Administration tool. To check the version of the license server on UNIX, run /var/
microfocuslicensing/bin/mfcesver or /var/microfocuslicensing/bin/
cesadmintool.sh.

If Micro Focus License Manager version 10000.2.02070 or older is installed, it must be uninstalled
before the product installation or upgrade can continue.

You can download the new version of the license server software from the Micro Focus SupportLine
Web site: http://supportline.microfocus.com.

Additional Software Requirements on Linux and UNIX

To ensure full functionality for some COBOL Server features, you might be required to obtain and install
additional third-party software in addition to the prerequisite software installed automatically by the COBOL
Server setup file.

Click here to see this information on the Product Documentation pages on Micro Focus SupportLine.
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UNIX and Linux Installer Issues

Installing while using AFS/Kerberos authentication

If you are using AFS/Kerberos authentication to log onto your Linux system then you need to ensure you
have a local user ID which SOA and Visual COBOL components of the product can use. This user ID must
be set up prior to running the installer. When running the installer you need to specify -
ESadminID=[User ID] on the command line so it is used by the installer.

License Server

You need to configure the computer hostname to ensure the license server will start properly.

To avoid performance issues, "localhost" and the computer hostname must not both be mapped to IP
address 127.0.0.1. You should only map "localhost" to IP address 127.0.0.1.

The following is an example of how to specify these entries correctly in the /etc/hosts file:

127.0.0.1 localhost.localdomain localhost
IP machinelonghostname machineshorthostname

where IP is the unique IP address of the computer in xx.xx.xx.xx format.

Basic Installation
The instructions in this section apply when you are performing a basic installation of this product for the
first time. If you are an administrator, you can perform a basic installation on a local machine before
performing a more advanced installation when rolling out the product to developers within your
organization.

For considerations when installing this product as an upgrade, for additional installation options or non-
default installations, see Advanced Installation Tasks in your product Help.

Installing on Windows
Note: If there is an earlier version of COBOL Server installed on your machine, check Installing as an
Upgrade first.

These are the steps to install this product:

1. Run the cs_50.exe file and follow the wizard instructions to install the prerequisite software and the
product.

The setup file will also install any missing prerequisite software as listed in Software Requirements.

Note:

• If you are installing onto a machine that has an existing Micro Focus product that uses an older
Sentinel RMS License Manager, you might be prompted to remove it and install the Micro Focus
License Administration. By doing this you maintain the existing Sentinel RMS license files while
adding the Micro Focus License Administration. If you are unsure about existing licenses on your
computer or removing the Sentinel RMS License Manager, consult your System Administrator. If
you want to proceed, remove Sentinel RMS License Manager by using Add or Remove
Programs (Windows XP) or Program and Features (Windows Vista or later), and rerun the
installation file.

• If do not choose to install Rumba+ at this time, but decide you want it later, you must then uninstall
Visual COBOL, and then rerun the installer with the Rumba+ option checked. As an alternative,
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you can use a different emulator, but be aware that instructions in this documentation often
assume that you are using the embedded Rumba+ Desktop emulator.

• Trial licenses cannot be used with remote desktop services. If you want to use your product in this
way, please contact Micro Focus SupportLine to obtain a relevant license.

• We recommend that you install any updates for the .NET Framework that are available at the 
Microsoft Download site.

• If you install JDK you might be prompted to install the latest update. The latest update is not
required for use with COBOL Server but you can install it if you wish.

Installing on UNIX
Note: Micro Focus offers two types of installers on UNIX and Linux - a proprietary Micro Focus
installer for installing on UNIX and Linux and a standard RPM (RPM Package Manager) installer for
installing on Linux. See your product Help for instructions on how to use the RPM installer.

These are the steps to install this product using the Micro Focus installer:

1. Give execute permissions to the setup file:

chmod +x setup_cobol_server_5.0_platform

2. Run the installer with superuser permissions:

./setup_cobol_server_5.0_platform

If you don't run this as superuser, you are prompted to enter the superuser password during the install.

If you set COBDIR to an already installed product, the installer will back up the existing installation and
will install this release in the location COBDIR points to. If COBDIR is not set, the installer does a fresh
install.

The COBOL run-time is installed by default into /opt/microfocus/VisualCOBOL, (COBDIR).

SafeNet Sentinel considerations

• The installation of this product could affect the SafeNet Sentinel licensed components running on your
machine. During installation licensing is shutdown to allow files to be updated. To ensure the processes
running on your machine are not affected, you need to use the -skipsafenet option, which skips the
installation of SafeNet:

./setup_cobol_server_5.0_platform -skipsafenet

• To protect the SafeNet Sentinel installation from accidental updating you can create an empty file
named SKIP_SAFENET_INSTALL in /var/microfocuslicensing/ as follows:

touch /var/microfocuslicensing/SKIP_SAFENET_INSTALL

While the file is present, the SafeNet installer does not make changes to the installation or shutdown the
running license daemons. If licensing needs to be updated later, remove the file and install Sentinel
RMS server manually.

Advanced Installation Tasks (Windows)
This section includes instructions about how to perform a non-default installation, install this product as an
upgrade, or about how to install any additional components.

The advanced installation tasks include:

• Installing as an Upgrade
• Command line installation options

Click here to see this information on the Product Documentation pages on Micro Focus SupportLine.
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Installing as an Upgrade
Before installing, check Installation Restrictions and Requirements.

Installing this release as an upgrade will automatically uninstall any HotFixes of the older version of the
product you have installed on your machine.

• Before installing this release as an upgrade, ensure you create a back-up of your Enterprise Server
configuration. To do this, on the Enterprise Server Administration home page, click Export and then
select Export Enterprise Server configuration and Security Manager definitions. This creates a
backup folder in the c:\programdata\micro focus\Enterprise Developer\MFDS. You can
restore the Enterprise Server configuration after installing this release - click Import on the Enterprise
Server Administration home page.

COBOL Server Installation Options
To install COBOL Server you run cs_50.exe which contains a number of product .msi files (Windows
Installer packages). When run, cs_50.exe performs some initial system checks then sequentially installs
the .msi files.

cs_50.exe can take a number of parameters, enabling you to specify a number of different types of
installation:

• Standard Installation

Format:
cs_50.exe

Summary:
Full installation including License Manager and COBOL Server. During installation you can specify
options including the location to which the components are installed.

• Non-interactive Installation

Format:
cs_50.exe /passive

Summary:
Full installation, but the components are installed non-interactively using default options and
directories.

• Silent Installation

Format:
start /wait cs_50.exe /q

Summary:
Full installation, but the components are installed non-interactively with no user interface, using
default options and directories.

• Modified Silent Installation

Format:
start /wait cs_50.exe /q InstallFolder=d:\cobolrts

Summary:
Full installation, but the components are installed non-interactively with no user interface, and
COBOL Server is installed to d:\cobolrts.

To see what parameters you can use, execute the following from the command line: cs_50.exe /?.

Note:
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• Log files that are created during installation are saved in the folder specified by the TEMP
environment variable. To change the location or name of the files, use the /log parameter on your
setup command line and specify the path and file name, for example: filename /log d:\temp
\log.txt. This creates a log file, named log.txt, in the d:\temp directory.

Advanced Installation Tasks (UNIX)
This section includes instructions about how to perform a non-default installation, install this product as an
upgrade, or about how to install any additional components.

The advanced installation tasks include:

• Installing as an Upgrade - included in these Release Notes
• Command line installation options - included in these Release Notes
• Installing using an RPM installer on Linux - available in the product Help and in the Micro Focus

Infocenter

Click here to see this information on the Product Documentation pages on Micro Focus SupportLine.

Installing as an Upgrade
This release works concurrently with the previous version of COBOL Server, so you do not need to
uninstall it.

Install the latest version in a different location and set the environment to point to it. To do this, run the
COBOL Server installer with the –installlocation option:

1. Execute the following command:

./InstallFile -installlocation="/opt/microfocus/VisualCOBOL"

Note: You can use variables when specifying an absolute path for –installlocation. For
example, the following examples are equivalent:

-installlocation="/home/myid/installdir"

-installlocation="$HOME/installdir"

2. Execute cobsetenv to set the environment and point to the new install location:

. <product-install-dir>/bin/cobsetenv

Note: cobsetenv is only compatible with POSIX-like shells, such as bash, ksh, or XPG4 sh. It is
not compatible with C-shell or pre-XPG4 Bourne shell.

Installation Options

Installing into a different location

To install in a different location use the -installlocation="Location" parameter to specify an
alternative directory location. For example:

./ -installlocation="full path of new location"

Note: You can use variables when specifying an absolute path for –installlocation. For
example, the following examples are equivalent:

-installlocation="/home/myid/installdir"

-installlocation="$HOME/installdir"

You can see details about which additional parameters can be passed to the install script if you enter the -
help option.
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Configuring Enterprise Server

You can use the following options to configure the Enterprise Server installation: [ -ESsysLog="Y/N" ]
[ -ESadminID="User ID" ] [ -CASrtDir="location" ], where:

-ESsysLog Use this to enable ("Y") or disable ("N") Enterprise Server system logging. Logging is
enabled by default. Log files are saved in /var/mfcobol/logs.

-ESadminID Sets the Enterprise Server System Administrator Process User ID from the command line -
for example, -ESadminID="esadm". The default user ID is the one that runs the installer.

-CASrtDir Specifies the location were the Enterprise Server run-time system files are placed - for
example, -CASrtDir="/home/esuser/casrt/es". The default location is /var/
mfcobol/es.

Installing Silently

You can install Micro Focus products silently by using command line parameters to specify the installation
directory, user information, and which features to install. You must execute the command with superuser
permissions.

You can use the following command line arguments to install silently on UNIX/Linux. You need to execute
the commands as root:

–silent -IacceptEULA

For example, execute:

setup_filename –silent -IacceptEULA

After Installing
• See Changes in Behavior or Usage in your product documentation and in the Release Notes for

important information about changes in this release that might affect existing applications.
• Check the Product Documentation section of the Micro Focus SupportLine Web site for any updates to

the documentation which might have been uploaded.

On Windows
To access the COBOL Server help:

• On versions of Windows 7 and earlier, select Start > All Programs > Micro Focus COBOL Server
2017 > Documentation from the Windows Taskbar.

• On Windows 8, right-click at the bottom of the Start screen, and click All apps to display all available
links for this product. In the COBOL Server section, click Documentation.

This opens the online Micro Focus Infocenter in a browser. From the left-hand pane, select Micro Focus
Developer > Micro Focus COBOL Server.

Repairing
If any product files, registry settings or shortcuts are accidentally removed at any point, you can perform a
repair on the installation to replace them.

To repair your installation on versions of Windows Vista or later:

1. From the Control Panel, click Uninstall a program under Programs.
2. Right-click your Micro Focus product and select Repair.

To repair your installation on older versions of Windows, such as Windows XP:
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1. Click Start Menu > Control Panel > Add/Remove Programs.
2. Click your Micro Focus product in the list of installed programs.
3. Click Click here for support information.
4. Click Repair.

Uninstalling
To uninstall the product, you cannot simply delete its files from your hard disk. To uninstall the product:

1. Log in with the same user-ID as you used when you installed the product.
2. Click Uninstall a program under Programs (or Add/Remove Programs on older versions of

Windows) in Control Panel.
3. On older versions of Windows such as Windows XP, ensure that Show Updates (at the top of the Add

or Remove Programs dialog) is checked, so that any hot fixes or WrapPacks are listed.
4. Select the product and click Remove or Uninstall as appropriate.

When you uninstall, the only files deleted are those that the installation software installed. If the product
directory has not been removed, delete any unwanted files and subdirectories within it using Windows
Explorer.

Important: The installer creates separate installations for Micro Focus COBOL Server and Micro
Focus License Administration. Uninstalling only COBOL Server does not automatically uninstall the
Micro Focus License Administration or any of the prerequisite software.

To completely remove the product you must uninstall the Micro Focus License Administration as well.

You can optionally remove the prerequisite software. For instructions, check the documentation of the
respective software vendor.

To silently uninstall the product, you need the setup file and you need to execute the following at the
command line:

start /wait install-file.exe /quiet /uninstall

On UNIX

Setting the Environment
When you have installed the product, you need to set the environment as described below.

1. To set up your product, execute:

. <product-install-dir>/bin/cobsetenv

2. To verify that your product is installed, execute:

cob -V

Important: These commands set the environment only for the current shell. You need to execute
them for each new shell that you start.

To avoid having to run cobsetenv for every shell, add these commands to the shell initialization files
(such as /etc/profile, /etc/bashrc).

Note that cobsetenv is only compatible with POSIX-like shells, such as bash, ksh, or XPG4 sh. It is
not compatible with C-shell or pre-XPG4 Bourne shell.

Repairing
If a file in the installation of the product becomes corrupt, or is missing, we recommend that you reinstall
the product.
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Uninstalling
Note: Before you uninstall the product, ensure that the Enterprise Server instances and the Micro
Focus Directory Service (MFDS) are stopped.

To uninstall this product:

1. Execute as root the Uninstall_COBOLServer5.0.sh script in the $COBDIR/bin directory.

Note: The installer creates separate installations for the product and for Micro Focus License
Administration. Uninstalling the product does not automatically uninstall the Micro Focus License
Administration or the prerequisite software. To completely remove the product you must uninstall the
Micro Focus License Administration as well.

To uninstall Micro Focus License Administration:

1. Execute as root the UnInstallMFLicenseServer.sh script in the /var/
microfocuslicensing/bin directory.

The script does not remove some of the files as they contain certain system settings or licenses.

You can optionally remove the prerequisite software. For instructions, check the documentation of the
respective software vendor.
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Licensing Information
Note:

• If you have purchased licenses for a previous release of this product, those licenses will also
enable you to use this release.

• The latest version of the SafeNet licensing software is required. See the Software Requirements
section in this document for more details.

• If you are unsure of what your license entitlement is or if you wish to purchase additional licenses,
contact your sales representative or Micro Focus SupportLine.

To buy and activate a full unlimited license
To buy a license for Visual COBOL, contact your sales representative or Micro Focus SupportLine.

For instructions on using the Micro Focus Licensing Administration Tool, see Licensing in the Visual
COBOL help.

To start Micro Focus License Administration

Windows 8, 8.1, and Windows
Server 2012

• From the Windows Start screen, click the License Administration
tile

Windows 10 and Later • From your Windows desktop, click Start > Micro Focus License
Manager > License Administration

Log on as root, and from a command prompt type:

/var/microfocuslicensing/bin/cesadmintool.sh

Installing licenses
You need either a license file (with a .mflic extension) or an authorisation code which consists of a string
of 16 alphanumeric characters.

If you have a license file

1. Start Micro Focus License Administration.
2. Click the Install tab.
3. Do one of the following:

• Click Browse next to the License file field and select the license file (which has an extension
of .mflic).
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• Drag and drop the license file from Windows Explorer to the License file field.
• Open the license file in a text editor, such as Notepad, then copy and paste the contents of the file

into the box below the License file field.
4. Click Install Licenses.

1. Start the Micro Focus License Administration tool and select the Manual License Installation option by
entering 4.

2. Enter the name and location of the license file.

If you have an authorization code

Authorizing your product when you have an Internet connection
Note:

• It is not possible to install licenses remotely. You must be logged into the machine on which you
are installing the licenses.

The following procedure describes how to authorize your product using a local or network license server.
The license server is set up automatically when you first install the product.

1. Start Micro Focus License Administration.
2. Click the Install tab.
3. Type the authorization code in the Enter authorization code field.
4. Click Authorize.

If you change the name of the machine running your license server after it has granted licenses, the
licenses stop working.

1. Start Micro Focus License Administration.
2. Select the Online Authorization option by entering 1 and pressing Enter.
3. Enter your authorization code at the Authorization Code prompt and then press Enter.

Authorizing your product when you don't have an Internet connection
This method of authorization is required if the machine you want to license does not have an Internet
connection or if normal (automatic) authorization fails.

1. Start Micro Focus License Administration.
2. Click Manual Authorization on the Install page.
3. Make a note of the contents of the Machine ID field. You will need this later.
4. Do one of the following:

• If your machine has an Internet connection, click the SupportLine Web link in the Manual
Authorization Information window.

• If your machine does not have an Internet connection, make a note of the Web address and type it
into a Web browser on a machine that has an Internet connection.

The Micro Focus SupportLine Manual product authorization Web page is displayed.
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5. Type the authorization code in the Authorization Code field. The authorization code is a 16-character
alphanumeric string supplied when you purchased your product.

6. Type the Machine ID in the Machine ID field.
7. Type your email address in the Email Address field.
8. Click Generate.
9. Copy the generated license string (or copy it from the email) and paste it into the box under the License

file field on the Install page.
10.Click Install Licenses.

In order to authorize your product you must have the following:

• Access to a computer which is connected to the Internet.
• Your authorization code (a 16-character alphanumeric string).
• The machine ID. To get this, start the Micro Focus License Administration tool and select the Get

Machine Id option by inputting 6. Make a note of the "Old machine ID".

If you have previously received the licenses and put them in a text file, skip to step 6.

1. Open the Micro Focus license activation web page http://supportline.microfocus.com/activation in a
browser.

2. Enter your authorization code and old machine ID and, optionally, your email address in the Email
Address field.

3. Click Generate.
4. Copy the licenses strings from the web page or the email you receive into a file.
5. Put the license file onto your target machine.
6. Start the Micro Focus License Administration tool and select the Manual License Installation option by

inputting 4.
7. Enter the name and location of the license file.

To obtain more licenses
If you are unsure of what your license entitlement is or if you wish to purchase additional licenses for Visual
COBOL, contact your sales representative or Micro Focus SupportLine.
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Updates and SupportLine
Our Web site gives up-to-date details of contact numbers and addresses.

Further Information and Product Support
Additional technical information or advice is available from several sources.

The product support pages contain a considerable amount of additional information, such as:

• The Product Updates section of the Micro Focus SupportLine Web site, where you can download fixes
and documentation updates. Go to https://supportline.microfocus.com/websync/
productupdatessearch.aspx

• The Examples and Utilities section of the Micro Focus SupportLine Web site, including demos and
additional product documentation. Go to https://supportline.microfocus.com/examplesandutilities/
index.aspx.

• The Support Resources section of the Micro Focus SupportLine Web site, that includes troubleshooting
guides and information about how to raise an incident. Go to https://supportline.microfocus.com/
supportresources.aspx

To connect, enter https://www.microfocus.com in your browser to go to the Micro Focus home page, then
click Support & Services > Support > Support Resources > All Support Resources by Product. In the
Browse by Product field, click the product you require, and then click Log into SupportLine.

Note: Some information may be available only to customers who have maintenance agreements.

If you obtained this product directly from Micro Focus, contact us as described on the Micro Focus Web
site, https://www.microfocus.com/support-and-services/contact-support/. If you obtained the product from
another source, such as an authorized distributor, contact them for help first. If they are unable to help,
contact us.

Also, visit:

• The Micro Focus Community Web site, where you can browse the Knowledge Base, read articles and
blogs, find demonstration programs and examples, and discuss this product with other users and Micro
Focus specialists. See https://community.microfocus.com.

• The Micro Focus YouTube channel for videos related to your product - see https://www.youtube.com/
user/MicroFocusIntl.

Information We Need
However you contact us, please try to include the information below, if you have it. The more information
you can give, the better Micro Focus SupportLine can help you. But if you don't know all the answers, or
you think some are irrelevant to your problem, please give whatever information you have.

• The name and version number of all products that you think might be causing a problem.
• Your computer make and model.
• Your operating system version number and details of any networking software you are using.
• The amount of memory in your computer.
• The relevant page reference or section in the documentation.
• Your serial number. To find out these numbers, look in the subject line and body of your Electronic

Product Delivery Notice email that you received from Micro Focus.
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On Windows, if you are reporting a protection violation you might be asked to provide a dump ( .dmp) file.
To produce a dump file you use the Unexpected Error dialog box that is displayed when a protection
violation occurs. Unless requested by Micro Focus SupportLine, leave the dump setting as Normal
(recommended), click Dump, then specify a location and name for the dump file. Once the dump file has
been written you can email it to Micro Focus SupportLine.

Alternatively, you might be asked to provide a log file created by the Consolidated Tracing Facility (CTF) - a
tracing infrastructure that enables you to quickly and easily produce diagnostic information detailing the
operation of a number of Micro Focus software components.

On Windows, you can use the Micro Focus SupportLine Support Scan Utility, MFSupportInfo, to create
either:

• a .log file that contains the details about your environment, Micro Focus SupportLine products, and
settings.

• a .zip archive that includes the same information as the .log file plus some product configuration
files from c:\ProgramData and the product installation log files.

MFSupportInfo.exe is stored in <install-dir>\bin.

To run MFSupportInfo:

1. Start a 32-bit Enterprise Developer command prompt.
2. Enter MFSupportinfo at the command prompt to start the utility.
3. Create a .log file or a .zip archive as follows:

a. To create a .log file, click File > Save.

This prompts to save the .log file, MFSupportInfo_Log_MachineName_YYYY-MM-DD_HH-MM-
SS.log, in the %temp% directory.

b. To create a .zip archive, click Tools > Create Zip Package.

This creates a .zip archive, MFSupportInfo_Log_MachineName_YYYY-MM-DD_HH-MM-
SS.zip, in the %temp% directory.

4. Send the diagnostic information to your Micro Focus SupportLine representative:

The following requires an Internet connection and an Email client:

a. Click Tools > Email Log to SupportLine to open the Email Log dialog box.
b. Fill in the required fields and click Send.

If the machine is not connected to the Internet or if there are no Email clients installed, copy either
the .log file or the .zip archive to a machine that is connected to the Internet. Use your Email client
to email the files to Micro Focus SupportLine at supportline@microfocus.com together with the Support
Incident (SI) number, if available, and any additional details that might be useful to diagnose the issues
that you are experiencing.

On UNIX, you can use the Micro Focus UNIX Support Scan Utility, mfsupport, to create a log file that
contains the details about your environment, product, and settings. The mfsupport script is stored in
$COBDIR/bin.

To run mfsupport:

1. Start a UNIX shell.
2. Set COBDIR to the product with issues.
3. Execute mfsupport from a directory where you have write permissions.

This creates a log file, mfpoll.txt, in that directory.
4. When the script finishes, send the mfpoll.txt file to your Micro Focus SupportLine representative.
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Note:

If COBDIR is set to a location that does not contain etc/cobver, the script outputs the contents
of /opt/microfocus/logs/MicroFocusProductRegistry.dat which keeps a list of the
installed Micro Focus products.

Creating Debug Files
If you encounter an error when compiling a program that requires you to contact Micro Focus SupportLine,
your support representative might request that you provide additional debug files (as well as source and
data files) to help us determine the cause of the problem. If so, they will advise you how to create them.
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Copyright and Disclaimer
© Copyright 2019 Micro Focus or one of its affiliates.

The only warranties for this product and any associated updates or services are those that may be
described in express warranty statements accompanying the product or in an applicable license agreement
you have entered into. Nothing in this document should be construed as creating any warranty for a
product, updates, or services. The information contained in this document is subject to change without
notice and is provided "AS IS" without any express or implied warranties or conditions. Micro Focus shall
not be liable for any technical or other errors or omissions in this document. Please see the product's
applicable end user license agreement for details regarding the license terms and conditions, warranties,
and limitations of liability.

Any links to third-party websites take you outside Micro Focus websites, and Micro Focus has no control
over and is not responsible for information on third party sites.
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